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LX7219/20 EVALUATION BOARD

USER’S GUIDE

Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
LX7219/20 Evaluation Board. Items discussed in this chapter include: 
• Document Layout 
• Conventions Used in this Guide 
• Recommended Reading 
• The Microchip Website 
• Customer Support 
• Document Revision History 

DOCUMENT LAYOUT
This document describes how to use the LX7219/20 Evaluation Board as a 
development tool. The manual layout is as follows:
• Chapter 1. “Product Overview” – Important information about the LX7219/20 

Evaluation Board.
• Chapter 2. “Installation and Operation” – Includes instructions on how to get 

started with the LX7219/20 Evaluation Board and a description of each function.
• Chapter 3. “GUI Installation and Operation” – Includes instructions on how to 

install the Graphical User Interface (GUI).
• Chapter 4. “GUI Description” – Describes the items in the GUI.
• Appendix A. “Schematic and Layouts” – Shows the schematic and PCB layout 

for the LX7219/20 Evaluation Board.
• Appendix B. “Bill of Materials” – Lists the parts used to build the LX7219/20 

Evaluation Board.
• Appendix C. “LX7219-01 Control Register Bit Definition” – Describes the 

internal registers.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2024 Microchip Technology Inc. and its subsidiaries DS50003624A-page 5
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat
File paths c:\mcc18\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-
Bit values 0, 1
Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50003624A-page 6  2024 Microchip Technology Inc. and its subsidiaries



Preface
RECOMMENDED READING
This user's guide describes how to use the LX7219/20 Evaluation Board. Other useful 
documents include the following Microchip documents listed below, which are available 
and recommended as supplemental reference resources:
• LX7219 Data Sheet – “6A Hysteretic Synchronous Buck Regulator with I2C 

Production”
• LX7220 Data Sheet – “2.7V to 5.5V, 6A Constant Frequency Hysteretic 

Synchronous Buck Regulator with I2C” (DS2006704A)

THE MICROCHIP WEBSITE
Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the website at: 
https://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision A (May 2024)
• Initial release of this document.
 2024 Microchip Technology Inc. and its subsidiaries DS50003624A-page 7
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LX7219/20 EVALUATION BOARD

USER’S GUIDE

Chapter 1.  Product Overview
1.1 INTRODUCTION
This chapter provides an overview of the LX7219/20 Evaluation Board and covers the 
following topics:
• LX7219/20 Short Overview
• What is the LX7219/20 Evaluation Board?
• Contents of the LX7219/20 Evaluation Board Kit

1.2 LX7219/20 SHORT OVERVIEW
The LX7219/20 are 6A step-down regulators with integrated MOSFETs, packaged in a 
space-saving 14-lead, 2 mm x 3 mm VQFN, for today's mobile devices. They use an 
ultra-fast, constant frequency hysteretic control method to minimize external filter com-
ponents while maintaining excellent regulation. The LX7219/20 reference voltage is 
programmable from 0.6V to 1.195V through a high-speed (up to 3.4 MHz), bidirectional 
I2C bus.
The LX7219/20 operate from 2.7V to 5.5V and outputs 0.6V to 3.3V.
Cycle-by-cycle current limiting protects against overcurrent conditions. Hiccup mode 
provides protection against heavy overload or short-circuit faults. Thermal protection 
shuts down the regulator under overtemperature conditions. Overvoltage conditions 
will immediately shut off the output to protect against permanent damage. The 
LX7219/20 automatically restart when all faults disappear.
This LX7219/20 Evaluation Board is compatible with LX7219-01, LX7219-02 and 
LX7220. The evaluation board is the same for all devices, but there are small differ-
ences between their operation. The default output voltage is 0.8V for LX7219-01, 
0.9V for LX7219-02 and 0.95V for LX7220.
The purpose of this evaluation board is to demonstrate the features of the LX7219/20 
devices.
 2024 Microchip Technology Inc. and its subsidiaries DS50003624A-page 9
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FIGURE 1-1: Typical LX7219-01 Buck Converter Application @ 0.8V Output.

1.3 WHAT IS THE LX7219/20 EVALUATION BOARD?
The LX7219/20 Evaluation Board is used to evaluate Microchip’s Technology 
LX7219/20 devices. The input voltage range for a typical output voltage of 0.8V for the 
LX7219-01 is 3-5.5V. The load current can go up to 6A.

1.4 CONTENTS OF THE LX7219/20 EVALUATION BOARD KIT
The LX7219/20 Evaluation Board kit includes:
• LX7219/20 Evaluation Board (EV97L85A)
• Important Information Sheet
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USER’S GUIDE

Chapter 2.  Installation and Operation
2.1 INTRODUCTION
The LX7219/20 Evaluation Board is offered with the LX7219-01 installed. The 
LX7219-01 operates using a 2.7V to 5.5V input rail, outputs 0.6V to 3.3V and can 
deliver an output current of up to 6A. Using the I2C interface, VOUT can be adjusted 
between 0.6V and 1.195V. The reference voltage is programmed via the I2C bus, using 
the VSEL register value. In case a higher output voltage is needed, it must be 
programmed through an external resistive divider; the regulated voltage (VOUT) should 
be lower than the input voltage (VIN).

FIGURE 2-1: Typical LX7219-01 Step-Down Converter Application: @ 0.8V Output and MCP2221A 
for I2C Communication.
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Note: The “DNP” marked components are optional and can be used for different 
configurations. Check the LX7219/20 Data Sheet for more information.
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2.2 FEATURES
The LX7219/20 Evaluation Board has the following features:
• Input Voltage Range (VIN): 2.7V - 5.5V
• Output Voltage: 0.6V to 3.3V
• Output Current: typically, 6A @ 0.8V Output, 5V Input
• Power Save Mode (PSM) can be selected to improve light load efficiency
• PWM Switching Frequency: 1.2 MHz
• Hysteretic Control offers optimized transient response
• Input Undervoltage and Overvoltage Protection
• Enable and Power Good Functions
• I2C Serial Interface at 3.4 Mbps
• Internal Soft Start
• Cycle-by-Cycle Overcurrent Protection
• Hiccup mode protects against short circuit Faults
• Seven Bit Adjustable Reference Voltage via I2C Bus
• Available in a 14L VQFN Package, 2 mm x 3 mm
• Overtemperature Protection (if the die temperature exceeds 150°C, with 20°C 

hysteresis)
• RoHS Compliant

2.3 GETTING STARTED
The LX7219/20 Evaluation Board is fully assembled and tested to evaluate and 
demonstrate the features of the LX7219 and LX7220 devices and comes with the 
LX7219-01 installed. This board requires the use of an external laboratory power sup-
ply and load. For I2C operation, the I2C Monitor GUI can be used (for more details, see 
Chapter 3. “GUI Installation and Operation” and Chapter 4. “GUI Description”). 
The differences among the various devices are described in the LX7219 and LX7220 
Data Sheets. 
This document describes the setup and operation of the board when the 
LX7219-01 is installed. The default output voltage is 0.8V. The LX7219-02, with a 
default output voltage of 0.9V, and LX7220, with a default output voltage of 0.95V, can 
also be installed. All device options may be fitted on the board as is.

2.3.1 Power Input and Output Connection

2.3.1.1 POWERING THE LX7219/20 EVALUATION BOARD

The LX7219/20 Evaluation Board provides a typical circuit application for a 0.8V output, 
used to evaluate the LX7219-01 product.
The switch peak current limit will provide a safe maximum current value. The maximum 
output current for the converter will vary with input and output voltage. Refer to the 
LX7219 Data Sheet for more information on the maximum output current.

2.3.1.2 BOARD POWER-UP PROCEDURE

For the power-up procedure, follow the steps below:
1. Connect the power supply to the input terminals of the evaluation board. The 

input voltage should be higher than VOUT, but it should not exceed the Absolute 
Maximum Ratings specified in the data sheet.
Connect the load to VOUT and GND terminals; maximum load varies with input 
and output voltage (see the LX7219 and LX7220 Data Sheets for more informa-
tion on the maximum load). Connect the (+) side of the load to VOUT terminal 
DS50003624A-page 12  2024 Microchip Technology Inc. and its subsidiaries



Installation and Operation
and the (-) side of the load to GND terminal of the board, see Figure 2-2.
2. Connect the board to a PC, using a USB to Micro-USB Cable.
3. To modify the mode of operation, to enable/disable the Input Overvoltage Protec-

tion and other features of the part, use the I2C Monitor GUI (for more details, see 
Chapter 3. “GUI Installation and Operation” and Chapter 4. “GUI Descrip-
tion”). By default, the EN pin is pulled high through a resistor. In addition to the 
EN pin, the regulator can be enabled and disabled through the I2C bus by 
programming the control register. While disabled, the regulator and most of the 
support circuitry is turned off. However, the I2C bus circuitry is still active and may 
be programmed.

4. After the power supply is turned on, a voltmeter can be used to monitor VOUT. 
The measured output voltage should be 0.8V, 0.9V or 0.95V, depending on the 
installed device. Adjusting the input voltage and load should not cause the output 
to vary more than a few mV over the operating range of the converter.

FIGURE 2-2: LX7219/20 Evaluation Board Test Setup.

2.3.1.3 ADJUSTABLE VOUT SETTING

Using the I2C interface, the output voltage can be adjusted from 0.6V to 1.195V. The 
reference voltage is programmed using the I2C bus VSEL register value.

EQUATION 2-1: VREF PROGRAMMING WITH THE I2C BUS VSEL REGISTER

In case a higher output voltage is needed, it must be programmed through an external 
resistive divider. The following formula calculates the value of VOUT based on the resis-
tive divider components RTOP and RBOT.

EQUATION 2-2: OUTPUT VOLTAGE CALCULATION

USB to Micro USB
Cable

VREF 0.6V VSEL 0.0047V+=

Where:
VSEL = the decimal value of the 7 VSEL bits.

VOUT VREF 1
RTOP
RBOT
------------+ 

 =

Where:
VREF default is determined by the chip (0.8V, 0.9V and 0.95V options are available).
 2024 Microchip Technology Inc. and its subsidiaries DS50003624A-page 13
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2.3.1.4 PERFORMANCE EVALUATION
The following plots show efficiency in PSM/PWM mode vs. load current and load 
transient response for the LX7219-01.

FIGURE 2-3: LX7219-01, Efficiency PSM/PWM Mode @ VOUT = 0.8V, 
VIN = 5.0V, L = 0.47 μH, CIN = 2 × 22 μF, COUT = 4 × 22 μF.

FIGURE 2-4: LX7219-01, Load Step Response, IOUT = 1A to 4A, L = 0.47 μH, 
CIN =2 × 22 μF, COUT =4 × 22 μF, VIN = 5.0V, VOUT = 0.8V.
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FIGURE 2-5: LX7219-01, Load Step Response, IOUT = 1A to 4A, L = 0.47 μH, 
CIN =2 × 22 μF, COUT =4 × 22 μF, Rising Edge, VIN = 5.0V, VOUT = 0.8V.

FIGURE 2-6: LX7219-01, Load Step Response, IOUT = 1A to 4A, L = 0.47 μH, 
CIN =2 × 22 μF, COUT =4 × 22 μF, Falling Edge, VIN = 5.0V, VOUT = 0.8V.

2.3.1.5 I2C PULL-UP VOLTAGE SELECTION

The LX7219/20 Evaluation Board is equipped with a jumper (JP2) for selecting the I2C 
pull-up supply voltage. The J2 header can be used to select the I2C pull-up voltage to 
either VBUS or VIN. If a different pull-up voltage is desired, it can be injected into the 
v+ pin of J2. In this case, please make sure that no jumper is inserted in header J2, to 
prevent shorting the externally injected pull-up voltage to either VBUS or VIN.
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Chapter 3.  GUI Installation and Operation
3.1 GETTING STARTED
In order to install, use, and evaluate the product, several software and hardware tools 
are required.

3.1.1 Required Software
• I2C Monitor GUI (minimum v8.0)
• Microsoft®.NET Framework 4.5 or higher

3.1.2 Required Hardware
• LX7219/20 Evaluation Board
• USB to micro-USB Cable

3.2 GRAPHICAL USER INTERFACE (GUI) INSTALLATION
The following steps describe how to install the I2C Monitor GUI:
1. If Microsoft.NET Framework is already installed, go to Step 2. If not, download 

Microsoft.NET Framework from www.microsoft.com and follow the installation 
instructions.

2. Download the I2C Monitor GUI (v8.0) archive from 
www.microchip.com/LX7219 under “Embedded Software”.

3. Unzip the I2C Monitor GUI archive, which contains the setup.exe file.
4. Double click the setup.exe file to open the Setup Wizard window and wait for 

the extraction to complete. If required, the installation can be stopped by pressing 
the Cancel button.
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5. In the Welcome to the I2C Monitor Setup Wizard window, click the Next button to 
start the installation.

FIGURE 3-1: Starting the I2C Monitor GUI Installation.

6. Read the Software License Agreement, check the agreement box, then click the 
Next button.

FIGURE 3-2: License Agreement.
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7. The installation path can be changed, although it is recommended to keep the 
default path. Click Next to continue.

FIGURE 3-3: Selecting the Destination Folder.

8. Click the Next button to start the installation.

FIGURE 3-4: Confirm Installation.
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9. The installation progress can be observed in the Installing I2C Monitor window.

FIGURE 3-5: Installing the I2C Monitor GUI.

10. Once the installation is complete, click Close to end the installation.
To start the GUI, either double-click the desktop icon or browse for “I2C Monitor” 
in the Windows Search bar.

FIGURE 3-6: The Installation Complete Window.
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Chapter 4.  GUI Description
4.1 INTRODUCTION
This chapter describes how to use the I2C Monitor GUI when connected to the 
LX7219/20 Evaluation Board included in the kit.

FIGURE 4-1: I2C Monitor GUI Main Window - LX7219-01 View.

NOTICE

This chapter provides information regarding the use of the GUI that applies only to the 
LX7219/20 devices. For other devices using the I2C Monitor GUI, please refer to their 
specific Data Sheets and User's Guides.

Device Menu

I2C Monitor Status
and

Control Bar

I2C Generic and
Register View

LX7219 or LX7220 I2C

Features

Status Bar
LX7219 or LX7220 I2C
Diagnostic

Progress Bar
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4.2 THE GRAPHICAL USER INTERFACE (GUI)
The following sections describe the items depicted in the GUI.

4.2.1 Device Menu
The Device drop-down menu allows the user to select the device to be evaluated. If an 
evaluation (or added custom) board is used, the profile will automatically change to the 
preselected profile.

4.2.2 File Menu
The File menu allows the user to save (Save registers to file) the registers of the cur-
rently selected device to a file that can then be loaded into the GUI by using the Load 
registers from file button. The saved file can also be edited (open it with a text editor).

FIGURE 4-2: File Menu.

4.2.3 Settings Menu
From the Settings menu, add a new custom board to be automatically detected and 
switch to its profile. To do this, go to Settings > Device descriptors and in the Descrip-
tors window, add the desired “Board” descriptor and select the desired “Device” profile.

FIGURE 4-3: Custom Board Menu.

4.2.4 I2C Monitor Status and Control Bar
The “Status and Control” bar contains the items listed in Table 4-1.

FIGURE 4-4: I2C Monitor Status and Control Bar.
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In the “Status and Control” bar, the user can choose the hardware tool used to commu-
nicate with the device and the settings it should allow.
In order to connect to a device, the user must follow the steps described in 
Section 3.1 “Getting Started”. After connecting the Micro-USB cable, the user must 
scan for a valid address. Once a valid address is detected, clicking the Connect button 
will initialize the connection with the device and the registers will be available for read 
and write operations.

4.2.5 I2C Generic Register View
The “I2C Generic Register View” area contains the items listed in Table 4-2. This sec-
tion of the I2C Monitor GUI is common for all evaluated devices.

FIGURE 4-5: Generic Register View Area.

The specific registers for LX7219-01 are described in the device data sheet, in section 
6.8 “Control Register Bit Definitions”.

TABLE 4-1: MONITOR STATUS AND CONTROL BAR
Item Description

Addr This drop-down menu shows the address of the available devices.
Connector This drop-down menu shows the type of connector used to connect the board.
ScanAddr This button is used to scan for a valid address.
Connect/Disconnect These buttons are used to connect/disconnect the currently selected device.
Voltage Not applicable.
Rate This drop-down menu is used to select the corresponding communication rate for the device.
Pull Ups Not applicable.

TABLE 4-2: I2C GENERIC REGISTER VIEW ITEMS
Panel Item Description

Operation Register This section shows the registers available for read/write operations.
Read/Write These buttons are used for single read/write operations.
Read All/Write All These buttons are used for reading/writing all the available registers.
Read Modified/
Write Modified These buttons are used for reading/writing the content of the modified registers.

Number of Registers In this section, the user can set the number of the available registers for 
read/write operations.

Address Size In this section, the Address Size is specified.

Update This button sets/updates the number of available registers for read/write opera-
tions in the register area.

Register Area This section shows the current status of the register addresses and their content.
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4.2.6 LX7219-01 I2C Programmable Features
The LX7219-01 I2C “Programmable Features” area contains the items listed in 
Table 4-3.

FIGURE 4-6: LX7219-01 I2C Programmable Features, Resistive Divider 
Disabled.

FIGURE 4-7: LX7219-01 I2C Programmable Features, Resistive Divider 
Enabled.
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TABLE 4-3: LX7219-01 I2C PROGRAMMABLE FEATURES
Panel/Button Items Description

Options Regulator Enabled This check box allows the user to enable/disable the regulator via 
the I2C bus. Uncheck the box to disable the regulator. During dis-
able, the regulator and most of the support circuitry is turned off; 
however, the I2C bus circuitry is still active and may be pro-
grammed.

Power Save Mode This check box allows the switch between auto PSM mode and 
PWM only mode. Check the box to enable the Power Save mode, 
uncheck the box for PWM only mode.

Output Discharge This check box allows the user to configure the Output Discharge 
option. If the box is checked, when the regulator is disabled, the 
output voltage is discharged through the SW pin.

45 ms Power Good Delay This check box controls the Power Good Delay. If checked, it will 
introduce a 45 ms delay on PGOOD.

Reduced Switch Node Rise 
Rate

This check box allows the user to select between Reduced and 
Normal Switch Node Rise Rate. If the box is checked, then the 
Reduced Switch Node Rise Rate is enabled. This feature is avail-
able only for LX7219-01 and LX7219-02. The LX7220 does not 
have this feature.

Read/Write These buttons are used to read/write the registers that contain 
the information described above.

Output Voltage Output Voltage This box allows the setting of the output voltage. If the Resistive 
Divider box is unchecked, then the allowed VOUT range is 
0.6V-1.195V. If the Resistive Divider option is enabled, the VOUT 
range can be extended to 3.3V.

Slew Rate This box contains a drop-down list with all possible slew rate set-
tings.

Resistive Divider This check box enables/disables the resistive divider configura-
tion. If the box is checked, the Top Resistor and Bottom Resistor 
fields become active and it is requested to fill in the configured 
values on the hardware.

VREF Voltage This spin box displays the resulting VREF Voltage. 
Error Message An error message is displayed in this area if the entered VOUT 

value is not valid.
Read/Write These buttons are used to read/write the registers that contain 

the information described above.
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This area of the GUI allows the user to modify the device features. For additional 
information about the part, please refer to its data sheet.

FIGURE 4-8: Output Voltage Transitions.

Target Voltage Target Output Voltage This box allows setting the target output voltage for VOUT transi-
tions. If the Resistive Divider is unchecked, then the allowed tar-
get VOUT range is 0.6V-1.195V. If the Resistive Divider option is 
checked, then the target VOUT range can be extended to 3.3V. 
Depending on the hardware-configured resistive divider, informa-
tion about the permitted target VOUT range is provided in the mes-
sage area.

Slew Rate This box contains a drop-down list with all possible slew rate set-
tings.

Target VREF Voltage This spin box displays the resulting Target VREF Voltage.
Info/Error Message This area provides information about the allowed target VOUT 

range. If a value that is not valid is set, then an Out of range! 
message is displayed.

Reverse (Target to Output) If VOUT is already set to the Target Output Voltage value and the 
box is checked, when the Start button is pressed, VOUT will return 
to the Output Voltage value.
If VOUT is set to the Output Voltage value and the box is checked, 
when the Start button is pressed, VOUT will transition to the 
Target Output Voltage value and, after approximately 80 ms, will 
return to the Output Voltage value, see Figure 4-8 (case C).

Start When this button is pressed, a transition from the Output Voltage 
to the Target Output Voltage starts; see Figure 4-8 (case A). If the 
Reverse (Target to Output) is checked, then a transition from the 
Target Output Voltage to the Output Voltage occurs; see 
Figure 4-8 (case B).

Reset to Default 
Register 
Settings

When this button is pressed, the registers are (re)set to their 
default values. The default values can be found in section 
6.8 “Control Register Bit Definitions” of the device data sheet.

TABLE 4-3: LX7219-01 I2C PROGRAMMABLE FEATURES (CONTINUED)
Panel/Button Items Description

VOUT
200 mV/div

Output Voltage
Target Output Voltage

Slew Rate = 0.8 mV/µs

“Reverse (Target to Output)”
box unchecked

200 µs/div
VOUT
200 mV/div

Output Voltage
Target Output Voltage
Slew Rate = 0.8 mV/µs

“Reverse (Target to Output)”
box checked

200 µs/div

VOUT
200 mV/div

Slew Rate = 0.8 mV/µs

20 ms/div

Output Voltage
Target 
Output 
Voltage

A B

C

“Reverse (Target to Output)”
box checked
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4.2.7 LX7219-01 I2C Diagnostic
The LX7219-01 Diagnostic area contains the items listed in Table 4-4.

FIGURE 4-9: LX7219-01 I2C Diagnostic Area.

The LX7219-01 I2C Diagnostic area summarizes the information contained in the 
“Status” section. The “Status” section contains latched (Flag) or non-latched (Status) 
bits. Flag bits are set when the corresponding Fault condition occurs and do not return 
to zero once the Fault condition ceases. If such a Fault occurs, the user can clear the 
Faults by clicking on the Clear Faults button or by power cycling the device. Status bits 
are set when the corresponding Fault condition has occurred and return to ‘0’ automat-
ically once the Fault condition has ceased. This information is refreshed once every two 
seconds.

TABLE 4-4: LX7219-01 I2C DIAGNOSTIC AREA
Panel Items Description

Status Power Good OK This box indicates green if the output voltage has reached 90% of 
its set value. It indicates red when the output voltage is in transition 
or the regulator is disabled.

Enabled This box indicates green if the regulator is enabled. When the Reg-
ulator Enabled box is unchecked, the Enabled box indicates red.

Over Current This box indicates red if the overcurrent limit is reached and it is 
latched to ‘1’. Press Clear Faults button to reset the status flag.

Over Temperature This box indicates red if an overtemperature event occurs and it is 
latched to ‘1’. Press Clear Faults button to reset the status flag.

Feedback Under Voltage Lockout This box indicates red if a feedback undervoltage event occurs and 
it is latched to ‘1’. Press Clear Faults button to reset the status flag.

TABLE 4-5: STATUS BAR ITEMS
Item Description

Status Label The status label shows if there is any device connected to the board. Refer to Table 4-6 for a list of 
possible labels.

Progress Bar This bar shows the progress for a given command.

TABLE 4-6: STATUS LABELS
Item Description

STATUS: Connected! This message is shown when the GUI is connected to a device.
STATUS: Disconnected! This message is shown when the GUI is not connected to a device.
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Appendix A. Schematic and Layouts
A.1 INTRODUCTION
This appendix contains the following schematic and layouts for the LX7219/20 Evalu-
ation Board:
• Board – Schematic 
• Board – Top Copper and Silk 
• Board – Signal Layer 1 
• Board – Signal Layer 2 
• Board – Bottom Copper and Silk 
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Schematic and Layouts
A.3 BOARD – TOP COPPER AND SILK

A.4 BOARD – SIGNAL LAYER 1
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A.5 BOARD – SIGNAL LAYER 2

A.6 BOARD – BOTTOM COPPER AND SILK
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Appendix B. Bill of Materials
TABLE B-1: BILL OF MATERIALS (BOM)
Qty Reference Description Manufacturer Part Number

6 C1, C2, C3, C4, 
C5, C6

Capacitor, Ceramic, 22 µF, 16V, 
20%, X7R, SMD, 1206

Murata Manufacturing Co., 
Ltd.

GRM31CZ71C226ME15L

1 C7 Capacitor, Ceramic, 1 µF, 16V, 
10%, X7R, SMD, 0603

Yageo Corporation CC0603KRX7R7BB105

1 C9 Capacitor, Ceramic, 0.1 µF, 16V, 
10%, X7R, SMD, 0603

Kyocera AVX® 0603YC104KAT2A

1 C10 Capacitor, Ceramic, 0.47  µF, 16V, 
10%, X7R, SMD, 0603

Murata Manufacturing Co., 
Ltd.

GRM188R71C474KA88D

2 EN, PG Test Point, LOOP, Orange, TH Keystone® Electronics 
Corp.

5003

4 GNDI, GNDO, 
VIN, VOUT

Test Point, PIN Tin, TH Harwin Plc. H2121-01

2 GNDI_SENSE, 
GNDO_SENSE

Test Point, Multi Purpose, Mini 
Black

Keystone Electronics Corp. 5001

2 J1, J2 Connector, Header, 2.54 mm, Male, 
1x3 Tin, 5.84 MH, TH, VERT

Samtec, Inc. TSW-103-07-T-S

1 J3 Connector, USB 2.0, Micro-B, 
Female, SMD

FCI 10118192-0001LF

1 L1 Inductor, 470 nH, 12.2A, 20%, SMD Vishay® Dale IHLP2020CZERR47M01
4 PAD1, PAD2, 

PAD3, PAD4
Mechanical HW Rubber Pad, 
Bumpon™ Hemisphere, 
0.44" x 0.20", Black

3M SJ-5003 (BLACK)

2 R1, R2 Resistor, Thick Film, 100 kΩ, 1%, 
1/10W, SMD, 0603

Vishay® Beyschlag MCT06030C1003FP500

1 R4 Resistor, Thick Film, 10R, 1%, 
1/8W, SMD, 0805

Bourns®, Inc. CR0805-FX-10R0ELF

4 R8, R12, R13, 
RT

Resistor, Thick Film, 0Ω, 1/10W, 
SMD, 0603

Panasonic® - ECG ERJ-3GEY0R00V

2 R10, R11 Resistor, Thin Film, 2.2 kΩ, 1%, 
1/8W, SMD, 0603

Vishay Beyschlag MCT06030C2201FP500

3 SW, 
VIN_SENSE, 
VOUT_SENSE

Test Point, Multi Purpose, Mini, Red Keystone Electronics Corp. 5000

1 PCB LX72XX Evaluation Board Printed 
Circuit Board

— 04-12011

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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TABLE B-2: BILL OF MATERIALS (BOM) – MICROCHIP PARTS
Qty Reference Description Manufacturer Part Number

1 U1 Analog Hysteretic 
Synchronous Buck Regulator, 6A, 
VQFN-14

Microchip Technology Inc. LX7219-01-02ILQTR

1 U2 Interface USB I2C UART, TSSOP-14 Microchip Technology Inc. MCP2221A-I/ST
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 

used in manufacturing uses all RoHS-compliant components.

TABLE B-3: BILL OF MATERIALS (BOM) – MECHANICAL PARTS
Qty Reference Description Manufacturer Part Number

1 JP2 Mechanical HW Jumper, 2.54 mm, 
1 x 2

Amphenol Corporation 63429-202LF

1 LABEL1 Label, ASSY, W/REV Level (Small 
Modules), PER, MTS-0002

Raynen 10010276

4 PAD1, 
PAD2, 
PAD3, 
PAD4

Mechanical HW Rubber Pad, Bumpon 
Hemisphere, 0.44" x 0.20", Black

3M SJ-5003 (BLACK)

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-4: BILL OF MATERIALS (BOM) – DO NOT POPULATE PARTS
Qty Reference Description Manufacturer Part Number

0 C8 Capacitor, Aluminum, 47 µF, 50V, 
20%, SMD F KEMET EDT476M050S9MAA

0 CF Capacitor, Ceramic, 6.8 pF, 100V, 5%, 
C0G, SMD, 0603 Kyocera AVX 06031A6R8JAT2A

0 R3, RB Resistor, Thin Film, 100 kΩ,1%, 1/8W, 
SMD, 0603 Vishay Beyschlag MCT06030C1003FP500

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Appendix C. LX7219-01 Control Register Bit Definition
TABLE C-1: LX7219-01 CONTROL REGISTER BIT DEFINITION
Bit Name Value Description

Status, Address 00h
7:3 Reserved
2 OCP 0-d Latched to 1 if the overcurrent limit is reached. Write a ‘1’ to reset the status flag.
1 OTP 0-d Latched to 1 if an overtemperature event occurs. Write a ‘1’ to reset the status flag.
0 FB_UVLO 0-d Latched to 1 if a FB_UVLO event occurs. Write a ‘1’ to reset the status flag.

VSEL, Address 01h, (aka dac)

7 EN
1-d Device enabled.
0 Device disabled.

6:0 VSEL[6:0] 7-bit DAC value to set VREF. The default value is determined by the REF ordering code 
of the part.

Ctrl1, Address 02h, (aka reg2)
7:6 Reserved 00-d
5 ctrl1 1-d Not used.

4 DLY_DIS
1 45 ms delay on PGOOD is enabled when this bit is high.

0-d Disable 45 ms delay on PGOOD.

3
SW_RATE
(LX7219-0

1 only)

1-d Reduced switch node rise rate.
0 High switch node rise rate.

2 Reserved
1-d
0

1 Reserved
1-d
0

0 MODE
1-d PSM - Power Save mode allows the converter to run in Discontinuous Conduction mode.
0 PWM - Always run in Continuous Conduction mode.

Vendor ID, Address 03h (Read Only)
7:4 VID[3:0] 0010 Microchip Vendor ID.
3:2 A1A0 00 Designates the client address version. These bits will correspond to the two LSB.
1:0 VOUT 01 Designates the default output voltage version. The default value is determined by the 

REF ordering code of the part.
Ctrl2, Address 04h, (reg4)
7:6 Reserved 00-d

5 GO
1 Write ‘1’ to start a VREF transition.

0-d The VOUT is ramped to the default VSEL value.

4 Discharge
1 When the regulator is disabled, the output voltage is discharged through the SW pin.

0-d When the regulator is disabled, the output voltage is not discharged.

3 PGOK
1 Is high when output is in regulation; read-only dynamic signal.
0 Is low during an output voltage transition; read-only dynamic signal.
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2:1 SLEW

00 Do not select.
01-d VREF slews at 0.8 mV/μs.
10 VREF slews at 2.2 mV/μs.
11 VREF slews at 8.4 mV/μs.

0 Reserved 1-d

TABLE C-1: LX7219-01 CONTROL REGISTER BIT DEFINITION (CONTINUED)
Bit Name Value Description
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